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CCA USER GUIDE

The software described in this book is furnished under a license agreement and may be used only in 
accordance with the terms of the agreement.

COPYRIGHT NOTICE

USER GUIDE © 1998-2006 TELEPHONY@WORK, INC.

All Rights Reserved.

Released: 07/24/06 for CCA 7.1 [R7M1.7SP3]

All intellectual property rights in the CCA USER GUIDE are owned by TELEPHONY@WORK, INC. and 
are protected by United States copyright laws, other applicable copyright laws and international treaty 
provisions. TELEPHONY@WORK, INC. retains all rights not expressly granted. 

This document may not, in whole or in part, be copied, photocopied, reproduced, translated, stored in 
a retrieval system, reduced to any electronic medium or machine-readable form or transmitted by any 
means, without prior consent in writing from Telephony@Work, Inc., 4225 Executive Square, Suite 
600, La Jolla, CA 92037.

ALL EXAMPLES WITH NAMES, PROJECTS, COMPANY NAMES, OR COMPANIES THAT APPEAR IN THIS 
MANUAL ARE IMAGINARY AND DO NOT REFER TO, OR PORTRAY, IN NAME OR SUBSTANCE, ANY 
ACTUAL NAME, PROJECT, COMPANIES, ENTITIES, OR INSTITUTIONS.  ANY RESEMBLANCE TO ANY 
REAL PERSON, PROJECT, COMPANY, ENTITY OR INSTITUTION IS PURELY COINCIDENTAL.

TRADEMARKS

Telephony@Work, the Telephony@Work logo, CCA, the CCA logo, Interaction Manager, Supervision 
Manager, Administration Manager, Network Manager, Mail Manager, Programmers Not Required and 
Integration-By-Design are the trademarks, service marks and logos of Telephony@Work, Inc. in the 
United States and other countries. Use of these marks is not permitted without the prior written 
consent of Telephony@Work, Inc. 

Proxy Gateway is a trademark of Funk Software, Inc. Other product names mentioned in this manual 
may be trademarks or registered trademarks of their respective companies and are the sole property 
of their respective owners.

DISCLAIMERS

Every effort has been made to ensure the accuracy of this user manual.  However, information in this 
document is subject to change without notice and does not represent a commitment on the part of 
Telephony@Work, Inc.  Telephony@Work, Inc. provides this information on an “as is” basis and makes 
no warranties with respect to this documentation and disclaims any implied warranties, including, 
without limitation, implied warranties of merchantability and fitness for a particular purpose. 
Telephony@Work, Inc. shall not be liable for any errors or for incidental or consequential damages in 
connection with the furnishing, performance, or use of this user manual or the examples herein.  

TELEPHONY@WORK, INC. LICENSE AND WARRANTY

NOTICE:   IF YOU HAVE SIGNED TELEPHONY@WORK, INC.'S STANDARD FORM SOFTWARE LICENSE 
AGREEMENT THEN THE TERMS OF THAT AGREEMENT SHALL GOVERN.   
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IF TELEPHONY@WORK, INC.'S STANDARD FORM SOFTWARE LICENSE AGREEMENT HAS NOT BEEN 
SIGNED THEN TELEPHONY@WORK, INC. LICENSES THE ENCLOSED SOFTWARE TO YOU ONLY UPON 
THE CONDITION THAT YOU PAY ALL SOFTWARE LICENSE FEES AND ACCEPT ALL THE TERMS 
CONTAINED IN THIS LICENSE AGREEMENT.  PLEASE READ THE TERMS CAREFULLY BEFORE OPENING 
THIS PACKAGE, AS OPENING THE PACKAGE WILL INDICATE YOUR ASSENT TO THEM.  IF YOU DO NOT 
AGREE TO THESE TERMS, THEN TELEPHONY@WORK, INC. IS UNWILLING TO LICENSE THE 
SOFTWARE TO YOU, IN WHICH EVENT YOU SHOULD RETURN THE FULL PRODUCT WITH PROOF OF 
PURCHASE TO THE DEALER FROM WHOM IT WAS ACQUIRED WITHIN THIRTY DAYS OF PURCHASE, 
AND YOUR MONEY WILL BE REFUNDED.

LICENSE 

The software that accompanies this license (the “Software”) is the property of TELEPHONY@WORK, 
INC. or its licensors and is protected by copyright law. Except as may be modified by a license 
addendum which accompanies this license, your rights and obligations with respect to the use of this 
Software are as follows:

You may:

- use one copy of the Software contained on the enclosed CD on a single computer;

- use the Software on a network.

You shall not:

- copy the documentation which accompanies the Software;

- sublicense, rent or lease any portion of the Software;

- copy, reverse engineer, decompile, disassemble, modify, translate, make any attempt to discover the 
source code of the Software, or create derivative works from the Software; or 

-use a previous version or copy of the Software after you have received a disk replacement set or an 
upgraded version as a replacement of the prior version.  Upon upgrading the Software all copies of 
the prior version must be destroyed unless otherwise agreed in a written document that has been 
signed by both you and TELEPHONY@WORK, INC. 

Any actions by you which violate the terms of this Agreement shall result in the immediate 
termination of this license with no refund to you of License Fees paid.

LIMITED WARRANTY

TELEPHONY@WORK, INC. warrants that the media on which the Software is distributed will be free 
from defects for a period of thirty (30) days from the date of delivery of the Software to you.  Your 
sole remedy in the event of a breach of this warranty will be that TELEPHONY@WORK, INC. will 
replace any defective media returned to TELEPHONY@WORK, INC. within the warranty period.  
TELEPHONY@WORK, INC. does not warrant that the Software will meet your requirements or that the 
operation of the Software will be uninterrupted or that the Software will be error-free. 

THE ABOVE LIMITED WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, AND NONINFRINGEMENT. THIS WARRANTY GIVES YOU SPECIFIC LEGAL 
RIGHTS.  YOU MAY HAVE OTHER RIGHTS THAT VARY FROM STATE TO STATE.



Telephony@Work, Inc., Confidential and Proprietary Information

v

DISCLAIMER OF DAMAGES

 

TELEPHONY@WORK, INC. SHALL NOT BE LIABLE TO YOU FOR INDIRECT, SPECIAL, INCIDENTAL, 
EXEMPLARY, CONSEQUENTIAL DAMAGES OR SIMILAR DAMAGES (INCLUDING, WITHOUT LIMITATION, 
LOST PROFITS OR LOST DATA) RELATED TO THIS AGREEMENT OR RESULTING FROM CUSTOMER'S 
USE OR INABILITY TO USE THE SOFTWARE, ARISING FROM ANY CAUSE OF ACTION WHATSOEVER, 
INCLUDING CONTRACT, WARRANTY, STRICT LIABILITY, OR NEGLIGENCE, EVEN IF 
TELEPHONY@WORK, INC. HAS BEEN NOTIFIED OF THE POSSIBILITY OF SUCH DAMAGES. SOME 
STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INDIRECT, SPECIAL, 
INCIDENTAL, EXEMPLARY, CONSEQUENTIAL DAMAGES OR SIMILAR DAMAGES SO THE ABOVE 
LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU. IN NO CASE SHALL TELEPHONY@WORK, INC.'S 
LIABILITY EXCEED THE PURCHASE PRICE FOR THE SOFTWARE. The disclaimers and limitations set 
forth above will apply regardless of whether you accept the Software.

GENERAL

The laws of the State of California will govern this Agreement. This Agreement may only be modified 
by a license addendum that accompanies this license or a written document that has been signed by 
both you and TELEPHONY@WORK, INC. Should you have any questions about this Agreement, or if 
you desire to contact TELEPHONY@WORK, INC. for any reason, please write: Telephony@Work, Inc. 
Customer Sales, 4225 Executive Square, Suite 600, La Jolla, CA 92037 or call 1-888-854-4224.
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1

Introduction to Custom/Advanced 
Reports 1

To provide for more effective Contact Center Management, CCA lets 
you create tabular and graphical reports to help you understand the 
trends, activities, and agent performance in your call center. These 
reports include:

• Agent activity, performance, and efficiency
• Interaction statistics
• Interaction outcomes
• Project billing and cost details
• Outcome of predictive calls
• Traffic information

As an administrator, you can configure any CCA report, which means 
you can:

• Display as much or as little data as needed.
• Specify a report date range.
• Display data in the graphical format that makes the most 

sense to you.
• Control which Administrators and Supervisors can access 

reports.
• Specify the date format, time zone, and language for the 

report.
• Schedule reports to run automatically.
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Overview of Custom/Advanced Reports
The CCA Advanced Report Templates allow you to configure highly 
detailed reports that provide information not available in the Standard 
Reports.

In addition, CCA presents Advanced Report information differently than 
Standard Reports, which presents information in an “all or one” 
format. You can set Advanced Reports to run in ways that compare 
multiple projects/workgroups/users and so on.

Table 1-1 shows the Advanced Report templates available from 
Custom Reports > Advanced Reports. 

Table 1-1. Administration Manager Custom/Advanced Reports

Advanced Report Description

Daily Project 
Performance

This report provides Call Center Activity by call 
number and call type, time measurements of 
contact center activity (ASA / ABA), talk time, and 
service level performance against pre-set 
thresholds.

Use this report to determine volume and service 
factors by project to identify busy hour and 
staffing requirements based upon call volume.

You can configure this report to show all activity 
for all projects or for individual projects you 
select, by interval, or by dates.

Interval Workgroup 
Performance

This report shows workgroup call activity, total 
workgroup ACD status time, and total number of 
agents logged in by an administrator-set interval.

Statistics tracked include:
Number, type and disposition of calls
Service levels
Collective time in ACD states
Agent login activity and visibility into ACD 
states

Use this report to identify volume, call routing, 
and service factors measured by the workgroup 
service level, as well as a user-defined service 
level.
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User Login/Logout This report shows agent login and logout activity 
by date, time, event, and reason.

Use this report to determine how a specific user is 
spending time in comparison with other users.

User Hourly Average This report highlights individual agent 
performance by time in ACD status, call counts, 
call types, and talk time. It provides visibility into 
hourly agent activity, including calls handled, 
along with time spent in different ACD states.

Use this report to determine agent average 
performance against reasonable expectations.

Daily User 
Performance

This report provides visibility into daily agent 
activity, including time spent in different ACD 
states, call counts, and talk time.

Use this report to monitor agent performance 
against reasonable expectations.

 Peak Interactions This report tracks the peak number of interactions 
in 15-minute intervals. (This information is stored 
in the Interactions Peak table in the database.)

Use this report to determine peak interaction 
activity for all projects or for individual projects.

System Peaks 
Interactions

This report tracks the maximum peak number of 
interactions used by the system, reported in 
pre-set intervals by company.

Use this report to determine when additional 
requirements may be needed to handle high 
volume interactions.

Interaction Outcome by 
Workgroup

This report tracks Interactions by outcome, 
number of Interactions per outcome duration, and 
average duration.

Service Billing Report 
- By Project

The report shows transaction times and billing 
rates by project, for a specified date range.

Use this report to determine transaction and 
billing activity for all projects or for individual 
projects.

Table 1-1. Administration Manager Custom/Advanced Reports

Advanced Report Description
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These reports are produced in PDF format. You will need Adobe 
Acrobat Reader to view these reports. 

User Status Duration This report tracks agent activity through the use 
of user-defined agent statuses. This provides 
more detail about the way an agent actually 
spends their time versus the standard ACD 
statuses of Available, Busy, and On Break. This 
report tracks:

User
Date
Status (company defined)
Duration
ACD status (system default)
Percent of total

Use this report to determine how a specific user 
spends time in comparison with other users.

Inbound Traffic Report This report provides a count of the number of 
calls offered by area code and exchange within 
that area code.

Use this report to determine the exchange with 
the largest volume of calls within each area code.

CCA supervisors cannot create or edit report definitions. If 
you are a supervisor and need a new report, or would like 
changes to an existing report, please contact your 
administrator.

Table 1-1. Administration Manager Custom/Advanced Reports

Advanced Report Description
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Creating, Viewing, and Printing 
Custom/Advanced Reports

Administrators can view and print Custom/Advanced Reports they or 
another Administrator created and saved for your company. 
Supervisors cannot create or edit report definitions.

1. Expand the Custom Reports link in the Navigation Pane. 

2. Then, expand the Advanced Reports link to see the reports 
under that heading (Figure 1-1).

Figure 1-1. 

Figure 1-1 Example of the Advanced Reports Menu

3. Click a report name (for example, Daily Project Performance). 
If no reports of that type exist, an empty report list appears. 
Figure 1-2 shows an example of an empty Daily Project 
Performance List.

You must install Adobe Acrobat Reader on all workstations 
of users who want to view Advanced Reports as well as 
Scheduled Advanced Reports.
CCA delivers Scheduled Reports in both Web (html) format 
as well as in Acrobat (pdf) format.
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Figure 1-2. Example Empty Report List

Figure 1-2 Example Empty Report List

If any reports of the requested type exist, a list of report names 
appears. Figure 1-3 shows an example list for the Daily Project 
Performance report. In this example, two reports are available.

Figure 1-3. Pop-Up Menu

Figure 1-3 List of Reports

4. Double-click on the desired report name.

When your administrator creates a report, the administrator can 
usually set some configuration options. Exactly what kind of 
configuration depends on each specific report.
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Every configuration option for every report is explained in the CCA 
Administration Manager User’s Guide. Work with your administrator to 
create the types of reports that are most useful to you.

Creating and Naming a New Advanced Report
1. From the list of available reports click the Add button. The report 

creation screen opens.

2. Select the Name tab, if it is not already selected. Figure 1-4 shows 
an example of the Name tab for the Daily Project Performance 
report.

Figure 1-4. Report Dialog Box: Period Covered Tab

Figure 1-4 Report Dialog Box: Period Covered Tab

3. Type a name in the Report Name box and a description in the 
Description box. This information will appear in the reports list for 
this report.
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4. Click the Content tab, which opens to the first of two sub-tabs; 
Projects and Report Interval.

Figure 1-5. 

Figure 1-5 Content Projects Tab

5. To include statistics on all projects, click All. To include statistics 
on only some reports, click Specific and then use the arrow keys 
to move the desired projects to the Selected Projects box.

6. Click the Report Interval tab (Figure 1-6) and, from the 
drop-down list, select how often to report statistics for the projects 
you included in this report.
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Figure 1-6. 

Figure 1-6 Content Report Interval Tab

7. Click the Regional Options tab (Figure 1-7).
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Figure 1-7. Regional Options Tab

Figure 1-7 Regional Options Tab

8. Using the information in Table 1-2, complete the fields.

9. Click the Schedule Report tab (Figure 1-8).

Table 1-2. Regional Options Tab Fields and Descriptions

Field Description

Display Time Choose Company Default Time Zone to display all 
report times in your company’s default time zone 
defined.

Choose User Time Zone to display all report times in 
your AM workstation’s configured time zone.

Report Language From the drop-down menu, select the language to use in 
this report.

Select Date Format 
to Display in 
Report

Choose Company Default Date Format to display all 
report dates in your company’s default format. 

Choose User Defined Date Format to display all 
report dates in your AM workstation’s configured format.
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Figure 1-8. 

Figure 1-8 Schedule Report Tab

10. Click Enable Report Scheduling and then select either Daily, 
Weekly, or Monthly.

11. Complete the fields under Send this Report by Email. 

a. In the To text box, enter one or more email addresses where 
CCA sends the report. Separate multiple email addresses with 
a semi-colon (;). For example: 

brice@indy500.com;gdefarran@indy500.com

Before using the scheduling feature the first time, you 
must make some minor edits to the report.xml file. See 
“Configuring the report.xml File” below.

The To field uses a maximum of 2048 characters.
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b. In the From text box, enter one email address. (The person 
who receives the report can see this address in the email’s 
From field.)

12. Select an SMTP group.

13. Click the Permissions tab (Figure 1-9), if available.

Figure 1-9. 

Figure 1-9 Permissions Tab

14. Make the report accessible to any Supervisor or to only the 
Supervisors you select in the list.

The From field uses a maximum of 128 characters.
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Viewing and Printing Reports
1. From the report list, click a report name and then the View 

button. The Report Period Covered dialog box (Figure 1-10) opens.

Figure 1-10. 

Figure 1-10 Period Covered Dialog Box

2. From the corresponding calendars, select the report coverage Start 
and End date.

3. From the corresponding drop-down lists, select the report coverage 
Start and End times.

4. Click the Regional Options tab (Figure 1-11).
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Figure 1-11. 

Figure 1-11 Regional Options Tab

5. Under Display Time, select either the company default time zone 
or user time zone. See “A Note About Start and End Times” on 
page 1-14.

6. Under Report Language, select a language for the report from the 
drop-down list.

7. In the last section, select a date format as either the company 
default format or a user-defined format.

8. Click OK. The report appears in a new window.

A Note About Start and End Times

For almost every report, the start and end times work the same. For 
example, run a Billing report using the following: 

Select: 

• Start date = 07/01/04
• End date = 07/30/04 
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• Start time = 8:00 (AM)
• End time = 17:00 (5:00 pm)

Any event occurring between those times, twenty-four hours a day, 
seven days a week, is included in the report. Every CCA report works 
this way -- with two standard report exceptions:

• The Workgroup Interval Time report
• The Workgroup Interval Time by Media report

Note About Project Routing and Reporting

If CCA receives a call into Project A and this changes another project 
(such as Project B), the report will show the change to Project A. This 
is because the change actually came into Project A and if CCA reported 
it for both Project A and Project B, then the information would be 
doubled. If CCA reported the change for only Project B, then there 
would be no way to tack which project the call actually came into. This 
is important for some clients who use multiple project DNISs that 
reroute to the same project or menu for tracking which advertising 
source is generating the most calls.

Configuring the report.xml File
The first time you use the report scheduling feature, you must make 
some minor edits to the report.xml file.

1. After installing the current build, find the report.xml file at: 

TAW/custom/report.xml

2. Open the file in a text editing program and verify that the following 
tags have correct values. The examples below show the default 
directory paths, but you should verify that these are correct for 
your site.

The “url” parameter should contain the URL path of your 
TAW web server:
<parameter

name=“url”
value=“http://<machine name>/TAW”

/>
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The “urlReportCss” parameter should contain the URL path 
to the web_clients.css file:
<parameter

name=“urlReportCss”

value=“http://<machine_name>/TAW/css/web_clients.css
” 

/>

The “urlReport” parameter should contain the URL path to 
the report directory:
<parameter

name=“urlReport”
value=“http://<machine_name>/TAW/AdministrationMana
ger/report”

/>

Deleting a Report

Follow these steps to delete any report.

1. just as when viewing a report (“Creating, Viewing, and Printing 
Custom/Advanced Reports” on page 1-50), in the Navigation Pane, 
click Custom Reports > Advanced Reports to view the selections.

2. Then, click on a report name (such as Daily Project 
Performance) to access a list of reports of that type.

3. Right-click on the report that you want to delete and select Delete 
from the pop-up menu (Figure 1-12). You can also select aa report 
and then click the Delete button.

After editing the report.xml file, you must restart the TAW 
Web server.
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Figure 1-12. Workgroup Key Statistics

Figure 1-12 Select Delete From the Pop-Up Menu

A delete confirmation message appears.

4. Click OK confirm the deletion.
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Deleted Objects and Historical Reports
Deleting an object (such as companies, Workgroups, Agents, Projects, 
Data Sources, and so on) from AM does NOT remove the object from 
the CCA database.

For example, if you delete a workgroup in AM, the workgroup is 
still in the database. CCA marks the workgroup as “do not display 
this workgroup in any CCA GUI.”

Because objects remain in the database forever, they can be picked up 
by reports containing historical data. 

This means, if you delete a workgroup on January 15th and then 
run a report showing workgroup activity going back to January 1st, 
the report will show activity from the deleted workgroup.
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Daily Project Performance 2

The Daily Project Performance (Figure 2-1) shows Call Center 
Activity by Call Number and Type, Time Measurements of Call Center 
activity, and Service Level performance against pre-set thresholds.

Figure 2-1. Sample Project Segments Report 

Figure 2-1 Sample Daily Project Performance Report
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You can also configure this report to show all activity by all projects or 
for selected individual projects.

Report Elements

On the top of the report:

• Daily Project Performance (report name)

• Date(s): The period covered start and end dates.

Project(s): The project names selected from the Contents - Projects 

• If the project name is too long for the space provided within 
the report, only part of the name appears.

• If the report includes more projects than room to completely 
display at the top of the report, the additional project names 
will appear at the bottom of the report.

• Contact Center Anywhere logo appears in the upper-right 
corner.

On the bottom center of the report:

• Report Printed On: The date and time based on the time zone 
selection.

• Page 1 of X (where X = the total number of pages).

The report includes three sections in its main body:

• Call Measures

• Time Measures

• Average Speed to Answer
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Call Measures
The Call Measures area tracks Call Type, Calls Offered, Calls Answered, 
and Percentage of Calls answered pre- and post-threshold. Refer to 
Table 2-1 for a description of each item, the corresponding table and 
field names, and the formula used in the calculation.

Time Measures (Avg)
The Time Measures (Avg) area provides information showing the 
Average time for the key statistical areas. Refer to Table 2-2 for a 
description of each item, table and field names, and the formula used 
in the calculation.

Table 2-1. Call Measures Area of the Daily Project Performance Report

Item Description

Total In Total Incoming Calls

Total Out Total Outgoing Calls

Internal In Total Internal Extension Calls

Internal Out Total Outgoing Extension Calls

Ans ACD Total ACD Calls Answered

Off ACD Total ACD calls offered by the project to the 
workgroup.

Table 2-2 time Measures (AVG) Area of Daily Performance Report

Item Description

Talktime ACD Duration Average talk time for all ACD calls in the project.

Talktime Out Duration Average talk time for all outbound calls.

ABDN ACD Duration Average time callers waited prior to abandoning a 
call.

Wrap ACD Duration Average wrap-up time for ACD calls.

Max ABND Longest time an ACD call was in queue prior to 
abandoning.

Total <date> For each day of a project, this is the total duration 
for each Time Measures item.
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Average Speed to Answer (ASA)
The Average Speed to Answer (ASA) area provides information 
showing the average time for the project to receive ACD calls. Refer to 
Table 2-3 for a description, table and field names, and the formula 
used in the calculation.

Total <Project 
Name>

Average for each item for the project, except Max, 
ABND ACD, which represents the maximum wait to 
abandoned for the project.

Grand Total Average for each item for all projects, except Max, 
ABND ACD, which represents the maximum wait to 
abandoned for all projects.

Table 2-3 Average Speed to Answer Area of the Daily Project 
Performance Report

Item Description

ACD ASA The average speed of answer for ACD calls received 
by the project.

Total <date> Average speed of answer for ACD calls for the day.

<Project Name> Average speed of answer for ACD calls for all days.

Grand Total Average ACD ASA for all projects.

Table 2-2 time Measures (AVG) Area of Daily Performance Report

Item Description
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Creating a Daily Project Performance Report
1. Click Reports > Project > Project Segments > the Add button.

2. The Add Report Definition screen opens to the Name tab. Use the 
information in Table 2-4 to complete the fields.

3. Click Content. The Content tab opens to the Projects Sub-Tab 
(Figure 2-2).

Figure 2-2. Project Segments Report: Content Tab

Figure 2-2 Content Tab > Projects Sub-Tab

Table 2-4. Name Tab Fields and Descriptions

Field Description

Report 
Name

Type a report name. The report name appears on each page of 
the report and in the Name column of the list of Project 
Segments Report definitions.

Description Type a description of the information in this report (or some text 
for differentiating this report from other reports of this type). 
The description appears in the Description column of the list of 
Project Segments Report definitions.
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4. Using the information in Table 2-5, complete the fields in the 
Projects Sub-Tab.

5. Click thee Report Interval Tab (Figure 2-3) and select how often to 
report the information, from the drop-down list (15 min., 30 min., 
60 min., or Daily).

Figure 2-3. 

Figure 2-3 Daily Project Performance - Content - Report Interval Tab

6. Click the Regional Options tab and select a time zone, report 
language, and report format. (Refer to Step 7 on page 1-9.)

Table 2-5. Projects Sub-Tab Fields and Descriptions

Field Description

All
or
Specific 

If you select All, then the report will include the statistics for all 
configured projects in the system, by Project and by Date.

If you select Specific, then you must also identify the individual 
projects to include in the report. Do this by moving them from 
the left box (Available Projects) to the right box (Selected 
Projects), using the arrows.
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7. Click the Schedule Report tab to run the report automatically, over 
selected periods of time, and have CCA automatically send it to 
one or more email addresses.

8. Click the Permissions tab and identify the users that you want to 
give access to this report.

a. Click the Any Supervisor button to give ALL supervisors 
access to the report. 

or

b. Click The Following Supervisors and then select supervisors 
from the list.

9. Click OK. 
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Interval Workgroup Performance 3

The Interval Workgroup Performance (Figure 3-1) tracks 
workgroup activity in 15-minute intervals. Statistics include:

• Number, Type, and Disposition of Calls

• Service Levels

• Collective time in ACD States

• Agent Login activity and visibility into ACD States
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Figure 3-1. Sample Project Segments Report 

Figure 3-1 Sample Interval Workgroup Performance Report

Report Elements

On the top of the report:

• Interval Workgroup Performance (report name)

• Date(s): The period covered start and end dates.

• Within Hours: The time range the report covers.

• Workgroup(s): The name of the workgroups identified in the 
Content tab.

On the bottom center of the report:

• Report Printed On: The date and time based on the time zone 
selection.

•

• Page 1 of X (where X = the total number of pages)
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The Workgroup Performance Report has four main areas:

• Calls

• TFS (Service Level)

• Time (Totals)

• Handled Time

• User Defined Threshold

Calls
The Calls area tracks the number and type of calls offered, the 
disposition of the call (answered, refused, abandoned, and so on) and 
the Service Level of the Workgroup against its pre-set threshold.

Refer to the information in Table 3-1 for a description of the fields, 
tables, and formulas used in the calculations, where applicable.

Table 3-1. Calls Area Elements of the Interval Workgroup Performance 
Report

Item Description

Time Beginning of 15-minute interval.

ACD In Total number of ACD calls offered within the 
interval.

Abn ACD Total number of Abandoned ACD calls within the 
interval.

Ref ACD Total number of Refused ACD calls during the 
interval. (ACD calls offered to the workgroup and 
not accepted.)

Wrap ACD Total number of calls that went into Wrap-up mode 
during the interval.

ACD Xfered In Number of ACD calls that were Transferred Into a 
workgroup during the interval.

ACD Xfered Out Number of ACD calls that were Transferred Out Of 
the Workgroup during the interval.
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TFS (Service Level)
Table 3-2 shows the TFS fields and descriptions.

ACD OVR In The number of calls that were offered by 
Overflowed to a workgroup.

ACD OVR Out The number of calls that met Overflow Criteria 
(though not necessarily answered by another 
workgroup).

Total The total number or percentage of each Call item, 
for each workgroup (during the requested date 
range).

Grand Total The total number or percentage of each Call item, 
for all selected workgroups combined (during the 
requested date range).

Table 3-2 TFS Area Elements of the Interval Workgroup Performance 
Report

Item Description

% Service Level The percentage of calls answered by a workgroup 
against a target within the interval.

Total The average Service Level percent for each Call 
item, for each workgroup (during the requested 
date range).

Grand Total The average Service Level percent for each Call 
item, for all selected workgroups combined (during 
the requested date range).

Table 3-1. Calls Area Elements of the Interval Workgroup Performance 
Report

Item Description
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Time (Totals)
The Time (Totals) area tracks the time that agents were logged in 
during the interval, the cumulative time spent in the different ACD 
States (Busy, Available, On Break), Maximum Abandon and Answer 
Delay, and the Average Speed of Answer (ASA).

Refer to Table 3-3 for a description of the fields, tables, and formulas 
used in the calculations, where applicable.

Table 3-3 Time (Totals) Area Elements of the Interval Workgroup 
Performance Report

Item Description

Logged In Cumulative total time users were logged in during 
the interval.

Busy Cumulative total time users spent in the Busy state 
during the interval.

Avail Cumulative total time users spent in the Available 
state during the interval.

On Break Cumulative total time users spent in the On Break 
state during the interval.

Max Answer Delay Maximum time to answer a call during the interval.

Max Abandon Delay Maximum time before the caller abandoned the call 
during the interval.

ACD ASA Average Speed to Answer during the interval.

Total The average total time for each Time field (except 
Max Answer Delay and Max Abandon Delay), for all 
workgroups combined (during the requested date 
range).

Total <date> The average time for each time field (except Max 
Answer Delay and Max Abandoned Delay) for the 
day.

Grand Total The average time for each time field for all 
workgroups combined during the requested date 
range.
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Handled Time
The Handled Time area tracks the total and average ACD Talk Time. 
Refer to Table 3-4 for a description of the fields, tables, and formulas 
used in the calculations, where applicable.

User-Defined Threshold
Refer to the information in Table 3-5 for a description of the fields, 
tables, and formulas used in the calculations, where applicable.

Table 3-4 Handled Time Area Elements of the Interval Workgroup 
Performance Report

Item Description

Total ACD Talk Time Total Talk Time (including Hold time) for ACD calls 
during the interval.

Avg ACD Talk Time Average Talk Time (including Hold time) for ACD 
calls during the interval.

Total Wrap Time Total time users are in the wrap-up state for this 
workgroup for the interval.

Avg Wrap Time Average time in wrap-up per call.

Total The total and average amount of time, for each Talk 
Time field, for each workgroup (during the 
requested date range).

Grand Total The total and average amount of time, for each Talk 
Time field, for all workgroups combined (during the 
requested date range).

Table 3-5 User-Defined Threshold Area Elements of the Interval 
Workgroup Performance Report

Item Description

Ans Pre Thresh The number of ACD calls that were answered (Ans) 
within (less than) the user-defined threshold within 
the daily group.

% Ans Pre Thresh The percentage of ACD calls that were answered 
(Ans) within (less than) the user-defined threshold 
within the daily group.



Interval Workgroup Performance 3-7

Ans Post Thresh The number of ACD calls that were answered (Ans) 
after (greater than) the user-defined threshold 
within the daily group.

% Ans Post Thresh The percentage of ACD calls that were answered 
(Ans) after (greater than) the user-defined 
threshold within the daily group.

Abn Pre Thresh The number of ACD calls that were abandoned 
(Abn) before (less than) the user-defined threshold 
within the daily group.

% Abn Pre Thresh The percentage of ACD calls that were abandoned 
(Abn) before (less than) the user-defined threshold 
within the daily group.

Abn Post Thresh The number of ACD calls that were abandoned after 
(greater than) the user-defined threshold within the 
daily group.

% Abn Post Thresh The percentage of ACD calls that were abandoned 
after (greater than) the user-defined threshold 
within the daily group.

Custom Service Level The percentage of calls that were answered within 
X seconds (where X is a Service Level time factor 
defined as a variable for the report).

Total The total number or percentage for each field for 
the workgroup.

Grand Total The total number or percentage for each field for all 
workgroups.

Table 3-5 User-Defined Threshold Area Elements of the Interval 
Workgroup Performance Report

Item Description
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Creating the Interval Workgroup Performance 
Report

1. From Advanced Reports, Interval Workgroup Performance, click the 
Add button. The Name tab opens, where you type a name and a 
description for the report.

2. Click the Content tab (Figure 3-2), which opens to show Include 
Statistics On tabs (Workgroups, Report Interval, Regional Options, 
Formulas, and Threshold).

Figure 3-2. Add Report Definition: Name Tab

Figure 3-2 Interval Workgroup Performance Report - Content - Workgroups Tab

3. Click the Workgroups tab (Figure 43) and select either All 
(workgroups) or Specific (workgroups) to include in you report.
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a. If you select All, then the report will include the statistics for all 
configured workgroups in the system, by Workgroup and by 
date.

b. If you select Specific, then you must identify the individual 
workgroups you want to include in the report. Do this my 
moving them from the left box (Available Workgroups) to the 
right box (Selected Workgroups), using the arrows.

4. Select the Report Interval tab (Figure 3-3) and select how often to 
report the information, from the drop-down list (15 min., 30 min., 
60 min., or Daily).

Figure 3-3. 

Figure 3-3 Interval Workgroup Performance - Content - Report Interval Tab

5. Select the Formulas tab (Figure 45) and select the formula for the 
TFS field from the drop-down list.
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Figure 3-4. 

Figure 3-4 Interval Workgroup Performance - Content - Formulas Tab

a. TotalAnsPreThre / (TotalAnsACD - TotalAbanPostThre) - 
Provides a service level percentage of calls answered within 
the threshold of all answered calls excluding calls that 
abandoned within the threshold value.

b. TotalAnsPreThre / TotalAnsACD - Provides a service level 
percentage of calls answered within the threshold of all 
answered calls.

6. Select the Threshold tab (Figure 3-5) and select a custom 
threshold (a Service Level time factor).
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Figure 3-5. 

Figure 3-5 Interval Workgroup Performance - Content - Threshold Tab

7. Click the Regional Options tab to select a time zone, report 
language, and report format.

8. Click the Schedule Report tab to run the report automatically, over 
selected periods of time, and have CCA automatically send it to 
one or more email addresses.

9. Click the Permissions tab and identify the users that you want to 
give access to this report.

10. Click OK.
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User Login/Logout Report 4

The User Login/Logout Repport (Figure 4-1) shows a set of 
interaction statistics, broken down by interaction type (phone, email, 
and so on), and as a summary across all interaction types.

Figure 4-1. Sample Project Segments Report 

Figure 4-1 Sample Daily Project Performance Report
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Report Elements

Table 4-1 provides the fields and descriptions for the Project 
Segments Report.

To create a Daily Project Performance Report

1. Click Reports > Project > Project Segments > the Add button.

2. The Add Report Definition screen (Figure 4-2) opens to the Name 
tab.

Table 4-1. Project Segments Report Fields

Item Description
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Figure 4-2. Add Report Definition: Name Tab

Figure 4-2 Add Report Definition: Name Tab

3. Using the information in Table 4-2, complete the fields.

4. Click Content. The Content tab (Figure 4-3) appears.

Table 4-2. Name Tab Fields and Descriptions

Field Description

Report 
Name

Type a report name. The report name appears on each page of 
the report and in the Name column of the list of Project 
Segments Report definitions.

Description Type a description of the information in this report (or some text 
for differentiating this report from other reports of this type). 
The description appears in the Description column of the list of 
Project Segments Report definitions.
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Figure 4-3. Project Segments Report: Content Tab

Figure 4-3 Project Segments Report: Content Tab

5. Using the information in Table 4-3, complete the fields.

6. Click Regional Options. The Regional Options tab (Figure 4-4) 
appears.

Table 4-3. Content Tab Fields and Descriptions

Field Description

Include 
Statistics 
On

Click the data group source to report:
• Inbound Calls
• Outbound Calls
• Chat
• Workgroup Email 
• Web Callback
• Predictive
• Preview

Projects Click the Project box and then, from the drop-down menu, select 
a project or All projects.
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Figure 4-4. Add Report Definition: Regional Options Tab

Figure 4-4 Add Report Definition: Regional Options Tab

7. Using the information in Table 4-4, complete the fields.

8. Click Permissions. The Permissions tab (Figure 4-5) appears.

Table 4-4. Regional Options Tab FIelds and Descriptions

Choose... To Display...

Company Default 
Time Zone

Report all times using the time zone that was set for the 
company.

User Time Zone Report all times using the time zone set for your 
workstation.

Report Language All report contents will be in the language selected.

Company Default 
Date Format

All dates will be formatted using the format set for the 
company.

User Defined 
Date Format

All dates will be formatted using the format set for your 
workstation.
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Figure 4-5. Add Report Definition: Permissions Tab

Figure 4-5 Add Report Definition: Permissions Tab

9. Click the Any Supervisor button to give ALL supervisors access to 
the report. 

or

Click The Following Supervisors and then select supervisors 
from the list.

10. Click OK (or Apply). 

• For how to view and print a report, see “Viewing and Printing 
Standard Reports” on page 15-6. 

• For how to delete a report, see “To delete a report” on page 
15-14.
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User Hourly Average Report 5

The User Hourly Average Report (Figure 5-1) shows a set of 
interaction statistics, broken down by interaction type (phone, email, 
and so on), and as a summary across all interaction types.

Figure 5-1. Sample Project Segments Report 

Figure 5-1 Sample Daily Project Performance Report
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Report Elements

Table 5-1 provides the fields and descriptions for the Project 
Segments Report.

To create a Daily Project Performance Report

1. Click Reports > Project > Project Segments > the Add button.

2. The Add Report Definition screen (Figure 5-2) opens to the Name 
tab.

Table 5-1. Project Segments Report Fields

Item Description
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Figure 5-2. Add Report Definition: Name Tab

Figure 5-2 Add Report Definition: Name Tab

3. Using the information in Table 5-2, complete the fields.

4. Click Content. The Content tab (Figure 5-3) appears.

Table 5-2. Name Tab Fields and Descriptions

Field Description

Report 
Name

Type a report name. The report name appears on each page of 
the report and in the Name column of the list of Project 
Segments Report definitions.

Description Type a description of the information in this report (or some text 
for differentiating this report from other reports of this type). 
The description appears in the Description column of the list of 
Project Segments Report definitions.
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Figure 5-3. Project Segments Report: Content Tab

Figure 5-3 Project Segments Report: Content Tab

5. Using the information in Table 5-3, complete the fields.

6. Click Regional Options. The Regional Options tab (Figure 5-4) 
appears.

Table 5-3. Content Tab Fields and Descriptions

Field Description

Include 
Statistics 
On

Click the data group source to report:
• Inbound Calls
• Outbound Calls
• Chat
• Workgroup Email 
• Web Callback
• Predictive
• Preview

Projects Click the Project box and then, from the drop-down menu, select 
a project or All projects.
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Figure 5-4. Add Report Definition: Regional Options Tab

Figure 5-4 Add Report Definition: Regional Options Tab

7. Using the information in Table 5-4, complete the fields.

8. Click Permissions. The Permissions tab (Figure 5-5) appears.

Table 5-4. Regional Options Tab FIelds and Descriptions

Choose... To Display...

Company Default 
Time Zone

Report all times using the time zone that was set for the 
company.

User Time Zone Report all times using the time zone set for your 
workstation.

Report Language All report contents will be in the language selected.

Company Default 
Date Format

All dates will be formatted using the format set for the 
company.

User Defined 
Date Format

All dates will be formatted using the format set for your 
workstation.
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Figure 5-5 Add Report Definition: Permissions Tab

9. Click the Any Supervisor button to give ALL supervisors access to 
the report. 

or

Click The Following Supervisors and then select supervisors 
from the list.

10. Click OK (or Apply). 

• For how to view and print a report, see “Viewing and Printing 
Standard Reports” on page 15-6. 

• For how to delete a report, see “To delete a report” on page 
15-14.



Daily User Performance Report 6-1

11

Daily User Performance Report 6

The Daily User Performance Report (Figure 6-1) shows a set of 
interaction statistics, broken down by interaction type (phone, email, 
and so on), and as a summary across all interaction types.

Figure 6-1. Sample Project Segments Report 

Figure 6-1 Sample Daily Project Performance Report
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Report Elements

Table 6-1 provides the fields and descriptions for the Project 
Segments Report.

To create a Daily Project Performance Report

1. Click Reports > Project > Project Segments > the Add button.

2. The Add Report Definition screen (Figure 6-2) opens to the Name 
tab.

Table 6-1. Project Segments Report Fields

Item Description
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Figure 6-2. Add Report Definition: Name Tab

Figure 6-2 Add Report Definition: Name Tab

3. Using the information in Table 6-2, complete the fields.

4. Click Content. The Content tab (Figure 6-3) appears.

Table 6-2. Name Tab Fields and Descriptions

Field Description

Report 
Name

Type a report name. The report name appears on each page of 
the report and in the Name column of the list of Project 
Segments Report definitions.

Description Type a description of the information in this report (or some text 
for differentiating this report from other reports of this type). 
The description appears in the Description column of the list of 
Project Segments Report definitions.
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Figure 6-3. Project Segments Report: Content Tab

Figure 6-3 Project Segments Report: Content Tab

5. Using the information in Table 6-3, complete the fields.

6. Click Regional Options. The Regional Options tab (Figure 6-4) 
appears.

Table 6-3. Content Tab Fields and Descriptions

Field Description

Include 
Statistics 
On

Click the data group source to report:
• Inbound Calls
• Outbound Calls
• Chat
• Workgroup Email 
• Web Callback
• Predictive
• Preview

Projects Click the Project box and then, from the drop-down menu, select 
a project or All projects.
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Figure 6-4. Add Report Definition: Regional Options Tab

Figure 6-4 Add Report Definition: Regional Options Tab

7. Using the information in Table 6-4, complete the fields.

8. Click Permissions. The Permissions tab (Figure 6-5) appears.

Table 6-4. Regional Options Tab FIelds and Descriptions

Choose... To Display...

Company Default 
Time Zone

Report all times using the time zone that was set for the 
company.

User Time Zone Report all times using the time zone set for your 
workstation.

Report Language All report contents will be in the language selected.

Company Default 
Date Format

All dates will be formatted using the format set for the 
company.

User Defined 
Date Format

All dates will be formatted using the format set for your 
workstation.
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Figure 6-5. Add Report Definition: Permissions Tab

Figure 6-5 Add Report Definition: Permissions Tab

9. Click the Any Supervisor button to give ALL supervisors access to 
the report. 

or

Click The Following Supervisors and then select supervisors 
from the list.

10. Click OK (or Apply). 

• For how to view and print a report, see “Viewing and Printing 
Standard Reports” on page 15-6. 

• For how to delete a report, see “To delete a report” on page 
15-14.
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System Peak Interactions Report 7

The System Peak Interactions Report (Figure 7-1) shows a set of 
interaction statistics, broken down by interaction type (phone, email, 
and so on), and as a summary across all interaction types.

Figure 7-1. Sample Project Segments Report 

Figure 7-1 Sample Daily Project Performance Report
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Report Elements

Table 7-1 provides the fields and descriptions for the Project 
Segments Report.

To create a Daily Project Performance Report

1. Click Reports > Project > Project Segments > the Add button.

2. The Add Report Definition screen (Figure 7-2) opens to the Name 
tab.

Table 7-1. Project Segments Report Fields

Item Description
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Figure 7-2. Add Report Definition: Name Tab

Figure 7-2 Add Report Definition: Name Tab

3. Using the information in Table 7-2, complete the fields.

4. Click Content. The Content tab (Figure 7-3) appears.

Table 7-2. Name Tab Fields and Descriptions

Field Description

Report 
Name

Type a report name. The report name appears on each page of 
the report and in the Name column of the list of Project 
Segments Report definitions.

Description Type a description of the information in this report (or some text 
for differentiating this report from other reports of this type). 
The description appears in the Description column of the list of 
Project Segments Report definitions.
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Figure 7-3. Project Segments Report: Content Tab

Figure 7-3 Project Segments Report: Content Tab

5. Using the information in Table 7-3, complete the fields.

6. Click Regional Options. The Regional Options tab (Figure 7-4) 
appears.

Table 7-3. Content Tab Fields and Descriptions

Field Description

Include 
Statistics 
On

Click the data group source to report:
• Inbound Calls
• Outbound Calls
• Chat
• Workgroup Email 
• Web Callback
• Predictive
• Preview

Projects Click the Project box and then, from the drop-down menu, select 
a project or All projects.
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Figure 7-4. Add Report Definition: Regional Options Tab

Figure 7-4 Add Report Definition: Regional Options Tab

7. Using the information in Table 7-4, complete the fields.

8. Click Permissions. The Permissions tab (Figure 7-5) appears.

Table 7-4. Regional Options Tab FIelds and Descriptions

Choose... To Display...

Company Default 
Time Zone

Report all times using the time zone that was set for the 
company.

User Time Zone Report all times using the time zone set for your 
workstation.

Report Language All report contents will be in the language selected.

Company Default 
Date Format

All dates will be formatted using the format set for the 
company.

User Defined 
Date Format

All dates will be formatted using the format set for your 
workstation.
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Figure 7-5. Add Report Definition: Permissions Tab

Figure 7-5 Add Report Definition: Permissions Tab

9. Click the Any Supervisor button to give ALL supervisors access to 
the report. 

or

Click The Following Supervisors and then select supervisors 
from the list.

10. Click OK (or Apply). 

• For how to view and print a report, see “Viewing and Printing 
Standard Reports” on page 15-6. 

• For how to delete a report, see “To delete a report” on page 
15-14.
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System Peaks (15 min) Report 8

The System Peaks (15 min) Report (Figure 8-1) shows a set of 
interaction statistics, broken down by interaction type (phone, email, 
and so on), and as a summary across all interaction types.

Figure 8-1. Sample Project Segments Report 

Figure 8-1 Sample Daily Project Performance Report



8-2 CallCenterAnywhereTM Advanced Reports

Report Elements

Table 8-1 provides the fields and descriptions for the Project 
Segments Report.

To create a Daily Project Performance Report

1. Click Reports > Project > Project Segments > the Add button.

2. The Add Report Definition screen (Figure 8-2) opens to the Name 
tab.

Table 8-1. Project Segments Report Fields

Item Description
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Figure 8-2. Add Report Definition: Name Tab

Figure 8-2 Add Report Definition: Name Tab

3. Using the information in Table 8-2, complete the fields.

4. Click Content. The Content tab (Figure 8-3) appears.

Table 8-2. Name Tab Fields and Descriptions

Field Description

Report 
Name

Type a report name. The report name appears on each page of 
the report and in the Name column of the list of Project 
Segments Report definitions.

Description Type a description of the information in this report (or some text 
for differentiating this report from other reports of this type). 
The description appears in the Description column of the list of 
Project Segments Report definitions.
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Figure 8-3. Project Segments Report: Content Tab

Figure 8-3 Project Segments Report: Content Tab

5. Using the information in Table 8-3, complete the fields.

6. Click Regional Options. The Regional Options tab (Figure 8-4) 
appears.

Table 8-3. Content Tab Fields and Descriptions

Field Description

Include 
Statistics 
On

Click the data group source to report:
• Inbound Calls
• Outbound Calls
• Chat
• Workgroup Email 
• Web Callback
• Predictive
• Preview

Projects Click the Project box and then, from the drop-down menu, select 
a project or All projects.
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Figure 8-4. Add Report Definition: Regional Options Tab

Figure 8-4 Add Report Definition: Regional Options Tab

7. Using the information in Table 8-4, complete the fields.

8. Click Permissions. The Permissions tab (Figure 8-5) appears.

Table 8-4. Regional Options Tab FIelds and Descriptions

Choose... To Display...

Company Default 
Time Zone

Report all times using the time zone that was set for the 
company.

User Time Zone Report all times using the time zone set for your 
workstation.

Report Language All report contents will be in the language selected.

Company Default 
Date Format

All dates will be formatted using the format set for the 
company.

User Defined 
Date Format

All dates will be formatted using the format set for your 
workstation.
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Figure 8-5. Add Report Definition: Permissions Tab

Figure 8-5 Add Report Definition: Permissions Tab

9. Click the Any Supervisor button to give ALL supervisors access to 
the report. 

or

Click The Following Supervisors and then select supervisors 
from the list.

10. Click OK (or Apply). 

• For how to view and print a report, see “Viewing and Printing 
Standard Reports” on page 15-6. 

• For how to delete a report, see “To delete a report” on page 
15-14.
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Interaction Outcome by Workgroup 
Report 9

The interaction Outcome by Workgroup Report (Figure 9-1) shows 
a set of interaction statistics, broken down by interaction type (phone, 
email, and so on), and as a summary across all interaction types.

Figure 9-1. Sample Project Segments Report 

Figure 9-1 Sample Daily Project Performance Report
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Report Elements

Table 9-1 provides the fields and descriptions for the Project 
Segments Report.

To create a Daily Project Performance Report

1. Click Reports > Project > Project Segments > the Add button.

2. The Add Report Definition screen (Figure 9-2) opens to the Name 
tab.

Table 9-1. Project Segments Report Fields

Item Description
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Figure 9-2. Add Report Definition: Name Tab

Figure 9-2 Add Report Definition: Name Tab

3. Using the information in Table 9-2, complete the fields.

4. Click Content. The Content tab (Figure 9-3) appears.

Table 9-2. Name Tab Fields and Descriptions

Field Description

Report 
Name

Type a report name. The report name appears on each page of 
the report and in the Name column of the list of Project 
Segments Report definitions.

Description Type a description of the information in this report (or some text 
for differentiating this report from other reports of this type). 
The description appears in the Description column of the list of 
Project Segments Report definitions.
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Figure 9-3. Project Segments Report: Content Tab

Figure 9-3 Project Segments Report: Content Tab

5. Using the information in Table 9-3, complete the fields.

6. Click Regional Options. The Regional Options tab (Figure 9-4) 
appears.

Table 9-3. Content Tab Fields and Descriptions

Field Description

Include 
Statistics 
On

Click the data group source to report:
• Inbound Calls
• Outbound Calls
• Chat
• Workgroup Email 
• Web Callback
• Predictive
• Preview

Projects Click the Project box and then, from the drop-down menu, select 
a project or All projects.
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Figure 9-4. Add Report Definition: Regional Options Tab

Figure 9-4 Add Report Definition: Regional Options Tab

7. Using the information in Table 9-4, complete the fields.

8. Click Permissions. The Permissions tab (Figure 9-5) appears.

Table 9-4. Regional Options Tab FIelds and Descriptions

Choose... To Display...

Company Default 
Time Zone

Report all times using the time zone that was set for the 
company.

User Time Zone Report all times using the time zone set for your 
workstation.

Report Language All report contents will be in the language selected.

Company Default 
Date Format

All dates will be formatted using the format set for the 
company.

User Defined 
Date Format

All dates will be formatted using the format set for your 
workstation.



9-6 CallCenterAnywhereTM Advanced Reports

Figure 9-5. Add Report Definition: Permissions Tab

Figure 9-5 Add Report Definition: Permissions Tab

9. Click the Any Supervisor button to give ALL supervisors access to 
the report. 

or

Click The Following Supervisors and then select supervisors 
from the list.

10. Click OK (or Apply). 

• For how to view and print a report, see “Viewing and Printing 
Standard Reports” on page 15-6. 

• For how to delete a report, see “To delete a report” on page 
15-14.
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Service Billing Report by Project 10

The Serrvice Billing Report by Project (Figure 10-1) shows a set of 
interaction statistics, broken down by interaction type (phone, email, 
and so on), and as a summary across all interaction types.

Figure 10-1. Sample Project Segments Report 

Figure 10-1 Sample Daily Project Performance Report
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Report Elements

Table 10-1 provides the fields and descriptions for the Project 
Segments Report.

To create a Daily Project Performance Report

1. Click Reports > Project > Project Segments > the Add button.

2. The Add Report Definition screen (Figure 10-2) opens to the Name 
tab.

Table 10-1. Project Segments Report Fields

Item Description
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Figure 10-2. Add Report Definition: Name Tab

Figure 10-2 Add Report Definition: Name Tab

3. Using the information in Table 10-2, complete the fields.

4. Click Content. The Content tab (Figure 10-3) appears.

Table 10-2. Name Tab Fields and Descriptions

Field Description

Report 
Name

Type a report name. The report name appears on each page of 
the report and in the Name column of the list of Project 
Segments Report definitions.

Description Type a description of the information in this report (or some text 
for differentiating this report from other reports of this type). 
The description appears in the Description column of the list of 
Project Segments Report definitions.
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Figure 10-3. Project Segments Report: Content Tab

Figure 10-3 Project Segments Report: Content Tab

5. Using the information in Table 10-3, complete the fields.

6. Click Regional Options. The Regional Options tab (Figure 10-4) 
appears.

Table 10-3. Content Tab Fields and Descriptions

Field Description

Include 
Statistics 
On

Click the data group source to report:
• Inbound Calls
• Outbound Calls
• Chat
• Workgroup Email 
• Web Callback
• Predictive
• Preview

Projects Click the Project box and then, from the drop-down menu, select 
a project or All projects.
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Figure 10-4. Add Report Definition: Regional Options Tab

Figure 10-4 Add Report Definition: Regional Options Tab

7. Using the information in Table 10-4, complete the fields.

8. Click Permissions. The Permissions tab (Figure 10-5) appears.

Table 10-4. Regional Options Tab FIelds and Descriptions

Choose... To Display...

Company Default 
Time Zone

Report all times using the time zone that was set for the 
company.

User Time Zone Report all times using the time zone set for your 
workstation.

Report Language All report contents will be in the language selected.

Company Default 
Date Format

All dates will be formatted using the format set for the 
company.

User Defined 
Date Format

All dates will be formatted using the format set for your 
workstation.
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Figure 10-5. Add Report Definition: Permissions Tab

Figure 10-5 Add Report Definition: Permissions Tab

9. Click the Any Supervisor button to give ALL supervisors access to 
the report. 

or

Click The Following Supervisors and then select supervisors 
from the list.

10. Click OK (or Apply). 

• For how to view and print a report, see “Viewing and Printing 
Standard Reports” on page 15-6. 

• For how to delete a report, see “To delete a report” on page 
15-14.
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User Status Duration Report 11

The User Status Duration Report (Figure 11-1) shows a set of 
interaction statistics, broken down by interaction type (phone, email, 
and so on), and as a summary across all interaction types.

Figure 11-1. Sample Project Segments Report 

Figure 11-1 Sample Daily Project Performance Report
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Report Elements

Table 11-1 provides the fields and descriptions for the Project 
Segments Report.

To create a Daily Project Performance Report

1. Click Reports > Project > Project Segments > the Add button.

2. The Add Report Definition screen (Figure 11-2) opens to the Name 
tab.

Table 11-1. Project Segments Report Fields

Item Description
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Figure 11-2. Add Report Definition: Name Tab

Figure 11-2 Add Report Definition: Name Tab

3. Using the information in Table 11-2, complete the fields.

4. Click Content. The Content tab (Figure 11-3) appears.

Table 11-2. Name Tab Fields and Descriptions

Field Description

Report 
Name

Type a report name. The report name appears on each page of 
the report and in the Name column of the list of Project 
Segments Report definitions.

Description Type a description of the information in this report (or some text 
for differentiating this report from other reports of this type). 
The description appears in the Description column of the list of 
Project Segments Report definitions.
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Figure 11-3. Project Segments Report: Content Tab

Figure 11-3 Project Segments Report: Content Tab

5. Using the information in Table 11-3, complete the fields.

6. Click Regional Options. The Regional Options tab (Figure 11-4) 
appears.

Table 11-3. Content Tab Fields and Descriptions

Field Description

Include 
Statistics 
On

Click the data group source to report:
• Inbound Calls
• Outbound Calls
• Chat
• Workgroup Email 
• Web Callback
• Predictive
• Preview

Projects Click the Project box and then, from the drop-down menu, select 
a project or All projects.
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Figure 11-4. Add Report Definition: Regional Options Tab

Figure 11-4 Add Report Definition: Regional Options Tab

7. Using the information in Table 11-4, complete the fields.

8. Click Permissions. The Permissions tab (Figure 11-5) appears.

Table 11-4. Regional Options Tab FIelds and Descriptions

Choose... To Display...

Company Default 
Time Zone

Report all times using the time zone that was set for the 
company.

User Time Zone Report all times using the time zone set for your 
workstation.

Report Language All report contents will be in the language selected.

Company Default 
Date Format

All dates will be formatted using the format set for the 
company.

User Defined 
Date Format

All dates will be formatted using the format set for your 
workstation.
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Figure 11-5. Add Report Definition: Permissions Tab

Figure 11-5 Add Report Definition: Permissions Tab

9. Click the Any Supervisor button to give ALL supervisors access to 
the report. 

or

Click The Following Supervisors and then select supervisors 
from the list.

10. Click OK (or Apply). 

• For how to view and print a report, see “Viewing and Printing 
Standard Reports” on page 15-6. 

• For how to delete a report, see “To delete a report” on page 
15-14.
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Inbound Traffic Report 12

The Inbound Traffic Report (Figure 12-1) shows a set of interaction 
statistics, broken down by interaction type (phone, email, and so on), 
and as a summary across all interaction types.

Figure 12-1. Sample Project Segments Report 

Figure 12-1 Sample Daily Project Performance Report
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Report Elements

Table 12-1 provides the fields and descriptions for the Project 
Segments Report.

To create a Daily Project Performance Report

1. Click Reports > Project > Project Segments > the Add button.

2. The Add Report Definition screen (Figure 12-2) opens to the Name 
tab.

Table 12-1. Project Segments Report Fields

Item Description
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Figure 12-2. Add Report Definition: Name Tab

Figure 12-2 Add Report Definition: Name Tab

3. Using the information in Table 12-2, complete the fields.

4. Click Content. The Content tab (Figure 12-3) appears.

Table 12-2. Name Tab Fields and Descriptions

Field Description

Report 
Name

Type a report name. The report name appears on each page of 
the report and in the Name column of the list of Project 
Segments Report definitions.

Description Type a description of the information in this report (or some text 
for differentiating this report from other reports of this type). 
The description appears in the Description column of the list of 
Project Segments Report definitions.
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Figure 12-3. Project Segments Report: Content Tab

Figure 12-3 Project Segments Report: Content Tab

5. Using the information in Table 12-3, complete the fields.

6. Click Regional Options. The Regional Options tab (Figure 12-4) 
appears.

Table 12-3. Content Tab Fields and Descriptions

Field Description

Include 
Statistics 
On

Click the data group source to report:
• Inbound Calls
• Outbound Calls
• Chat
• Workgroup Email 
• Web Callback
• Predictive
• Preview

Projects Click the Project box and then, from the drop-down menu, select 
a project or All projects.
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Figure 12-4. Add Report Definition: Regional Options Tab

Figure 12-4 Add Report Definition: Regional Options Tab

7. Using the information in Table 12-4, complete the fields.

8. Click Permissions. The Permissions tab (Figure 12-5) appears.

Table 12-4. Regional Options Tab FIelds and Descriptions

Choose... To Display...

Company Default 
Time Zone

Report all times using the time zone that was set for the 
company.

User Time Zone Report all times using the time zone set for your 
workstation.

Report Language All report contents will be in the language selected.

Company Default 
Date Format

All dates will be formatted using the format set for the 
company.

User Defined 
Date Format

All dates will be formatted using the format set for your 
workstation.
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Figure 12-5. Add Report Definition: Permissions Tab

Figure 12-5 Add Report Definition: Permissions Tab

9. Click the Any Supervisor button to give ALL supervisors access to 
the report. 

or

Click The Following Supervisors and then select supervisors 
from the list.

10. Click OK (or Apply). 

• For how to view and print a report, see “Viewing and Printing 
Standard Reports” on page 15-6. 

• For how to delete a report, see “To delete a report” on page 
15-14.
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